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Install the bundled software programs,
and download images to the computer.

¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

¢ You may download images without installing this software.
However, there are several limitations (p. 77).
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use
of the products and to prevent injuries to yourself or other persons, or damage to property.
Please read and ensure that you understand them before proceeding to other sections of the
guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer hearing loss from listening with headphones to the
loud sounds of a CD-ROM played on a music CD player.

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the memory cards,
personal computers, peripheral devices, or use of non-Canon memory cards.

Canon Customer Support

For Canon Customer Support contacts, please see the customer support list supplied with your
camera.



Table of contents

Read This First 3
Precautions ... 3
It's so Simple! Make Prints Right at Home Like a Pro ........cccccceuees 4
Unbounded Possibilities with Entertaining Software ........c..cc........ 5
System REQUIrEMENTS ......eiiiiiiiiiiii e 9

Using the Software on the Windows Platform

- Preparations 11
Installing the SOftWare ..o 1
Using the Software on the Windows Platform

— The Basics 15
Downloading Images to the Computer ........ccoevceeriiiiiinien e 15
Printing IMages ...oooooiiiiiiee ittt e 20
Using the Software on the Windows Platform

— Advanced Techniques 22
The ZoomBrowser EX WiNAOWS .........ccoccierieeiiieieenie e 22
ZoomBrowser EX FEAtUres .......cccoceiiiiieciiieen e 28
Operating the Shutter Remotely (Remote Shooting) .......ccccceeenne. 32
Merging Panoramic Images — PhotoStitch .....c.ccccovvveneiciniiceenns 35
Processing RAW IMages ........cceieiuiieiiiiiiiieee e cieeee e seeee e sseeeee e 36

Enjoy Customizing Your Camera with the My Camera Settings ...39

Using the Software on the Macintosh Platform

— Preparations 43
Installing the SOftWare ........ccccovvcie e 43
Using the Software on the Macintosh Platform

— The Basics 45
Downloading Images to the Computer ........cccccceeeviciieeecccciieeee s 45

Printing IMages ...ooooieiiiie e 49



2

Table of contents

Using the Software on the Macintosh Platform

— Advanced Techniques 51
The ImageBrowser WIiNndOWS ........cccceeeiieerrviereneneneeeeseeeesenee e 51
ImageBrowser FEAtUIes .........oceioieiiiieieeee e 57
Operating the Shutter Remotely (Remote Shooting) .......ccccceennne. 61
Merging Panoramic Images — PhotoStitch .....c.cccocvvecveriiiniiceenns 64
Processing RAW IMages .......coeiiiiiiieiiiiiiieee et eeeee e seeeee e 65
Enjoy Customizing Your Camera with the My Camera Settings ...68
Appendices A
Uninstalling the Software ... 71
Memory Card Folder Structure ........cccccooiriiininiieeeeeeeeee e 72
TroubleshOOoting ....cceoiiiiiieeiee e 73
Downloading Images without Installing the Software ................. 77
[T =) G S S SRR 78
Using the PDF Manuals

The following PDF manuals are provided to explain the features and procedures
for using ZoomBrowser EX and ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

¢ ImageBrowser Software User Guide (Macintosh)

manuals.

Iﬁl Adobe Reader must be installed to read the aforementioned

These manuals are available on the Canon website.
Use your browser program to download these manuals from the following URL:
http://web.canon.jp/imaging/information-e.html




This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide

¢ The explanations in this guide are based on Windows XP and Mac OS X v10.4. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.

¢ The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.4-v10.5)

Precautions

Precautions for Connecting the Camera to the Computer

*The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.

¢ The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

¢ Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

e Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.

*You are recommended to use an AC adapter (sold separately) when
connecting to a computer. Ensure that you use fully charged batteries if you
cannot use an AC adapter.

¢ See the Camera User Guide for procedures connecting the camera to the
computer.
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It's so Simple! Make Prints Right at Home
Like a Pro

— Windows (p. 20)
Macintosh (p. 49)

~— Shoot the images -
See your Camera User Guide for
g shooting instructions.
o
\ y
v
~— Install the software on the computer ~
Just install the software once at the
@ @3 beginning.
Windows (p. 11)
Macintosh (p. 43)
\ y
v
~— Connect the camera to the computer ~
See your Camera User Guide for
connecting instructions.
Precautions for Connecting the
| Camera to the Computer (p. 3)
. v
~= Download images to the computer -
i = g/ 3\ |
— Windows (p. 15)
Macintosh (p. 45)
\
- - v
~— Print the images ~




Unbounded Possibilities with Entertaining
Software

ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)

Versatile image management software for downloading images, editing still images and
movies, and printing.

Experiment with diverse printing techniques

Print a variety of layouts. Change paper sizes and print your photos with date stamps and
comments to enjoy an expanded range of possibilities.
Windows (p. 20)  Macintosh (p. 49)

Printing images is easy

LT

Print date [P s R P

vl os AT
e
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Print comments on your = E ==

postcards and invitations
Check multiple photos at
a glance with index
printing.

Edit a Movie

You can remove unwanted sections at the beginning or end of a movie. You can also use the
memory card reader to upload the edited movie to the camera.
Windows (p. 26)  Macintosh (p. 55)

Extract Stills from Movies

You can extract a still from the displayed movie and save it as a new image file.
Windows (p.26) Macintosh (p. 55)
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Operate the Camera Shutter from the Computer (Remote Shooting)

Shoot and control the camera’s shutter from a computer. You can save the recorded images
directly to the computer. (Certain models only)
Windows (p. 32)  Macintosh (p. 61)

Enjoy Customizing Your Camera (My Camera)

Set your favorite images and sounds as the camera’s start-up image or shutter sound. (Certain
models only)
Windows (p. 39) Macintosh (p. 68)
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PhotoStitch (Windows/Macintosh)

A program for merging multiple images into dramatic panoramas.

Stitch a Panorama Together

Windows (p. 35)  Macintosh (p. 64)

B
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System Requirements

Please install the software on a computer meeting the following minimum requirements.
Even though these are recommended system requirements, not all computer functions can be

guaranteed.

oS

Windows Vista (including Service Pack 1)

Windows XP Service Pack 2

Computer Model

The above OS should be pre-installed on computers with built-in USB

ports.
CPU Still Windows Vista: Pentium 1.3 GHz or higher
Images | Windows XP: Pentium 500 MHz or higher
Movies | Core 2 Duo 2.6 GHz or higher
RAM Still Windows Vista: 512 MB or more
Images | Windows XP: 256 MB or more
Movies | 2 GB or more
Interface UsB

Free Hard Disk
Space

e Canon Utilities
- ZoomBrowser EX:
- PhotoStitch:
- Digital Photo Professional

200 MB or more

40 MB or more

200 MB or more
(certain models only)

Display

1,024 x 768 pixels/High Color (16 bit) or better

(01 Mac OS X (v10.4-v10.5)
Computer Model The above OS should be pre-installed on computers with built-in USB
ports.

CPU Still PowerPC G4/G5 or Intel Processor
Images
Movies | Core 2 Duo 2.6 GHz or higher

RAM Still Mac OS X v10.5: 512 MB or more
Images | Mac OS Xv10.4: 256 MB or more
Movies | 2 GB or more

Interface USB

Free Hard Disk e Canon Utilities

Space - ImageBrowser: 300 MB or more

- PhotoStitch: 50 MB or more

- Digital Photo Professional

200 MB or more
(certain models only)

Display

1,024 x 768 pixels/32,000 Colors or better
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If you will be using Digital Photo Professional, check the “Processing Raw Images” section also
(Windows, p. 36; Macintosh, p. 65) (certain models only).

e Even if there is nothing wrong with a movie file, it may drop frames while
playing, not play smoothly, or the audio may cut out depending on your
computer specifications.

¢ A CD-ROM drive is required to install the software.

¢ A sound card is required to play movie file audio tracks in Windows.

o With Windows, Microsoft .NET Framework 2.0 or later is required.

¢ Macintosh software can only be used on disks formatted in the Mac OS
Extended (journaled) format.

Previous ZoomBrowser EX/ImageBrowser Versions
*|If you are already using a prior version, use the supplied CD-ROM (Canon

Digital Camera Solution Disk) to install and overwrite it with the new
version.

o |f you were using ZoomBrowser EX Ver. 2 or 3, perform the following
procedures after installing the software.

1. Double-click [dbconverter.exe] to start it.
Example: C:\Program Files\Canon\ZoomBrowser EX\Program Folder\dbconverter.exe

2. Select the database file used up to now and click the [Start] button.
Example: C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd

If images were saved in the Program Files folder, then continue with the
following procedure.

3. Copy the image folders in the Program Files folder to the [My Pictures]
folder.
Example: C:\Program Files\Canon\ZoomBrowser EX\Library (1)




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

* Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.
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3  Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the [User Account Control] window appears, follow the
on-screen instructions to proceed.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel

Use the following procedures to display the installer panel if it does not appear
automatically.

1. Select [Computer] or [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

{ ('b b
. Double-click the [SETUPEXE]* \v) icon.
. When [User Account Control] window displays, follow the on-screen instructions to
proceed.

W

Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software [Easy
Installation] button. Sabe DIGITAL CAMERA
To individually select the software to install, Solution Disk
click [Custom Installation].

Digitsl g

—_—,
S—————

Installer Panel

5 If other software is running, close each
program before clicking [OK].

Start instaling Digital Camera Solution Disk.
Close any othet open applications and click [0K].




6 Review the installation settings and
click [Install]. Confirmation

E e owss EX amre

{2y proosun e

The items in the list may differ from those
illustrated depending on the software
installed on your computer.

Ve £ ESETEIoR O 1 SEAwan by DSS) VEL TELSS ver 1P FUves of e

C\progarm Fles|Carerst

Clek [nstaf] to start instaling.

-

7 ik [Yes] if you agree to all of the

terms of the software license

License

agreement. (

The installation will start. P i
stepdl . Finich

Follow the on-screen instructions to

proceed with the installation.

Click [Yes] if a dialog confirming the

installation of Microsoft .Net Framework

displays.

Lcense Agreement
Areement ¢ the

softwe.

www“mmmw»wmnmwmw
e e oo
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Canon Sefmas Laenge Aesnert.
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THI AGEEEVENT, IF PO D W31 AGREE 19 THE TERME GF THE AGREEMENT
FRGIFILY CLOSE THIS MSTALLATICA FROGRAN. TH 3CHCA

SCETWARE WILLMOT B DISTALLED 460 YOU WILL HAVE MOIRIGHT TOLEETT. 34

ik [es] 0 accept tha Licrrsa Agreerent, If yous cick Mo, the nstalstion
o Digtl Camara Sclabon Det: vl b cancece,
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8 When the installation is over, select
[Restart computer immediately
(Recommended)] and click [Restart].

At this stage, do NOT remove the Solution
Disk from the CD-ROM drive yet.

| Finish

Installation of the software has been completed.

[ Restant computer immediately (Reco

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive to conclude the installation.

13
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© Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Iﬁl See Uninstalling the Software (p. 71) to delete the installed programs.

To ensure security on computers with Microsoft .NET Framework
installed, it will be necessary to update the computer using Windows
Update.

You may now download camera images to the computer (p. 15).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Windows Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 18).

Camera to Computer Connection

1 After connecting the supplied interface cable to the computer’s USB port and the
camera'’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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2 Select [Canon CameraWindow]
when a dialog (Events dialog)
similar to that on the right
displays and click [OK]. iz cinieasied]

In Windows Vista, select [Downloads
Images From Canon Camera using
Canon CameraWindow] from the
AutoPlay dialog.

Select the program to launch for this action:

1 Camers >

73 Microzoft Scanner and Camera ‘Wizard
Download pictures from a camera or scanner

Your camera model name or
[Canon Camera] will appear here.

Different programs may display
depending on your computer setup.

[ Alwayz use this program far thiz action

< L oK ] D Cancel

If this Events dialog does not appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[CameraWindow] and [CameraWindow].

CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

CameraWindow

6/12/2008

Operate using the camera

Push the camera buttons.

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window

3 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] or [My Pictures] folder.
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Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

*When it is possible to use the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Dhan
(Print/Share) button will light blue.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the £yas (Print/Share)
button or the FUNC./SET button.

Direct Transfer
> ALl Tmages..

The s (Print/Share) button will blink AL B—
blue during the transfer and remain lit [ Select & Transfer
when it is complete. Click the mouse B Wallpaper.

button or press any key on the keyboard to
resume the ability to operate from the
computer.

Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow

mon Uniuie:

(-Zamera:Window DC

Operate using the camera

Push the camera buttons.

Click this button to
close the start screen.

Thumbnail Window View Window

¢ To download images that have had transfer settings set with the
camera, use the camera or a memory card reader.
¢ To check images in the camera or to download only a portion of the
images, click [Operate Images on Cameral].
*You can choose standard or frame-by-frame playback of movies by
selecting a movie in the Thumbnail Window.

=
* You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.
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When you click [OK] in the image transfer completion window, the transferred images will

display in the Main Window.

The downloaded images are saved into folders according to the shooting date.

£ Zoomrowses % - All noges

The last downloaded images
will display here according
to both their shooting dates
and categories.

A wages 3 Q-0 ko et Fam -

H MG O001PG  IMGOMEPG MG O0OFG  IMGONMTG

Folders Area
The downloaded symbol

displays on downloaded
folders.

M5 005 PS  IMGOMEFG [M3_OM7FG

Thumbnail

Next, print out the images (p. 20).

Memory Card Reader Connection

Insert the memory card into the reader.
Use a separately sold card adapter if required.

See the manual for the memory card reader for its connection and handling instructions.

Select [View/Download Images using
Canon ZoomBrowser EX] when the
dialog to the right appears and click
[OK].

[ &lways do the selected acty
‘ [ Ok ] ) Cancel
—

proceed to Step 3.

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [ZoomBrowser EX
Memory Card Utility], [ZoomBrowser EX Memory Card Utility], and




3 Click [Download Images].

ZoomBrowser EX Canon

ey | eeem—
. . T ——
You can adjust the settings, such as Lets youselectand |
the type of image downloaded and —

the destination folder, by clicking [ PrintMenu
[Preferences].

o

Preferences.. Exit

K

¢ By default, all the images that have yet to be downloaded will
download to the [Pictures] or [My Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

¢ Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

*See Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date and category in the [Last Acquired
Images] section.

Next, print out the images (p. 20).
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Printing Images

There are three methods for using ZoomBrowser EX to print images: [Photo Print], [Index Print]
and [Print Using Other Software]. This section explains how to use the [Photo Print] option.

¢ Movies cannot be printed, but you can print still images saved from movies.
¢ To use the Index Print option, click [Print & Email] in the Main Window,
followed by [Index Print].

Prints one image on each page.

1 ik [Print & Email] in ZoomBrowser EX's Main Window, followed by [Photo
Print].

47 ZovmBrawser EX - Al Images
Fin Edk View Took Irtemet Fup Fle E® ‘View Took Inferet Help
Taoks -] Y

8] Ao b, Camers Seitigs

ZoomMode | Sciolbode | P 18] oquet Canwra Selfngs

]|‘| Vierr bk Classly Al

=

g —
P

2 After confirming that [1. Select Images] is selected, select images.

You can select multiple images by holding the [Ctrl] key down while clicking on successive
images.

7 Zoombrovwser £X - All moges

The background of
selected images
changes to blue.

Use tissaskc o printthe selecied.
ohoizs. sach ane on & saparsls
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3 cdlick [2. Printer and Layout Settings] and adjust the categories as you feel
necessary.

Text can be inserted here to print
with this photo.

Fraka Satings and Friview.

@ Fiamoe unwarted
jans ofyour phots
g eSS

Selects the printer
and the paper size
etc.

Ao 101 BS2 AT %

7] Borderless

Selects a printing
method for the
shooting date/time
information.

Sets the number
-|— of print copies.

This button switches between images if
multiple images were selected.

4 Click [3. Print].
Printing will start.

This chapter explained the ZoomBrowser EX basics.
Once you have mastered them, try the advanced techniques.

¢ Using the Software on the Windows Platform — Advanced Techniques (p. 22).



This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Buttons (p. 23)

Function Buttons (p. 25)

Faverke Foiders | A1 Fokdes
Wiy Pebres,
7% zoas_06_12
L8] 2009_06_13
) Sesch et

Folders Area (p. 23)

Last Acquired Images (p. 23)

Display Mode
(p. 24)

Display Control
Panel (p. 25)

Browser Area
(p. 23)

Switches between
showing and
hiding the Task
Buttons and Last
Acquired Images
section and the
Folders Area.



Task Buttons

e ZoomBrowser EX's tasks are arranged here like an index.
e Click a Task button to carry out the desired task.
These features are described in ZoomBrowser EX Features (p. 28)

Folders Area

¢ Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

¢ If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

o If [Favorite Folders] is displayed: click [Add] and select a folder.

o |f [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Last Acquired Images
¢ You can check images grouped according to the shooting date or My Category.

Browser Area
¢ The folders and the images within the folders selected in the Last Acquired Images section or

Folders Area display here. The display style will vary according to your Display Mode selection.

¢ You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by selecting [View] and [Sort by].
¢ The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode

m RAW images
bzl  Movies

Images with sound memo attachments
Protected images

Images shot with the camera's AEB function

BOAES0

Rotated Images (In display only)

23
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Display Mode

o Selects the display style for the Browser Area.

Zoom Mode

Displays all the images in a folder as thumbnail
images. This mode is convenient for searching
for images since many can be displayed at
once.

If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.

If you move the mouse cursor over a folder,
t=a] will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

The images within the selected folder and
subfolders will display. If you set the display
folder depth (level) to [1] or greater, the
thumbnails of the images in the folder will also
display. You can change the folder depth in the
[Tools] menu under the [Preferences] option.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

In zoom mode or scroll mode, positioning the mouse pointer over a
thumbnail causes the image to appear at a higher magnification in a Mouse
Over window. You can also set the Mouse Over window to not show in the
@ - (Show Information) menu.
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Display Control Panel
¢ This panel adjusts the display settings for the Browser Area.
Selection Menu Fit to Window Display Size
Click this to select/deselect all  Changesthe thumbnailsizeto Changes the size of the
images in the Browser Area. fit them into the window. thumbnail in the Browser Area.

]

QOO0 &- i|3 -[h]E & Do §F Filer -

Show/Hide Image Information Menu Filter Tool Menu

Select here to show/hide such image Displays only images that
information as the file name or correspond to the specific
shooting date or rating beneath the conditions.

thumbnail.

Select Button
Use this to select images
in Zoom mode.

Function Buttons
¢ These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
or movie in the Viewer selected images. image.

Window. | |

— ] - [ - M
=i | View Image Properties [.;J:_lg Slide Show \ﬁ Search ‘.j Delete I E}l Rotate

I_I

Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteria as the images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu
You can edit, eliminating red eyes,
adjusting colors and brightness,
cropping and inputting titles. You can

i Shootin .
also use it to start up other programs o ing Synchronize Button
for editing. nformation |
Display Button Synchronlzgs the
Print Button Displays image dls;?l_ayl settings when
Prints the displayed image. shooting g’:;‘ t|Lp :dlmages are
information. played.

= ZoomBrowser EX - C:\Docume 1ts and SettingsboodMy Documentsidy Pictures\2008_06_10uMG_ooo .1eG [2 B[]

I—®+\7x ) B Lew- 8 sow: (|8 el FH

Image Selector R el GTRIE D)o e D Number of
Button Displays
Switches between Button
images. Dlspl_ays
multiple
Sets the image  — images at
display size to the once. This is
size in the Viewer handy fpr
Window. comparing
images.

Displays images in —

the Viewer
Window at their
actual size.
| Zoom Ratiot 4106
I
Zoom Star Rating
Changes the image Sets the Star Rating for an image.

zoom setting.
Full Screen Button
Displays the image in the full screen mode. Click the image or
press any key on the keyboard to restore the normal display mode.

*RAW Image is Displayed
The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed
eButtons will appear beneath the movie, allowing it to be played or the
sound to be adjusted.
*You can extract still images from movies by clicking the [Save as still image] button,
which appears beside the Star Ratings buttons. You can also delete unwanted
sections at the beginning or end of movies by clicking the [Cut Movie] button.




Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

— Plays a sound memo attached
to an image.

categories.
Muodified: £/12/2008
File Size: 4706 KB
Image Size: 1600 » 1200
Data Type: JPG
Sound:
Path: C:ADocuments and Settingshwexi My Docume
{2 File Name:
File Name {IMG_oon \

The file name
can be changed.

Star Rating and
My Category
Sets the rating
for an image.
An icon will
display if a My
Category is set.

Shooting Information
Displays detailed
information, such as the
shutter speed and
exposure compensation
setting. The camera model
will determine what
information is displayed.

WA

Sl ¥ g el el Bl ]

Comment;

in K.amakura

Protect
Prevents an image from being
overwritten or deleted.

Comment

K.epwords:

Wigw/Madify Keywords

Brightress Histogram:

m
| e |

Shooting Information: |

Item Mame Walue 45
File Mame IMG_0001.JPG

Camera Model Name  Canon 234 0
Shoaoting Date/Time  B12/2008 9:15:22 AM
Shaoting Made Auta

Tw [Shutter Speed)
A [bperture Value) 71

1 ink b mbrivn b b fmimbad e

' [ < Previous ] Next > 1 '—

You can type a comment here.

— Keywords
Sets the keywords used in
searches.

— Brightness Histogram

A graph of the highlights and
shadows distribution in an
image.

L Image Selector Buttons

If multiple images are selected
with the Properties Window
displayed, you can switch
between the images for which
the information is displayed.

27
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ZoomBrowser EX Features

This section briefly introduces the ZoomBrowser EX features.

Some ZoomBrowser EX functions may not be available with certain camera
models. Check the Specifications section of your Camera User Guide to see if
your model supports them.

The following workflow is used in ZoomBrowser EX.

'l Click a Task button.

Check the Help menu for
procedures and features.

Task Buttons

The Task buttons are explained in “Task Button Functions” (p. 29).

2 Pperform the procedures according to the instructions.

Summary of the
procedures for this step

el Frovie

e ofymerpaci.

Steps to follow

Temimage

42 101 £4152 dm

) Borcstnss

Procedural instructions

Shosting ete/Time
=

Return to Main Menu

[ <Prevoe i Cancel.

Sin o
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Task Button Functions

Acquire & Camera Settings -
Connect to Camera ) Acquire & Camera Settings

You can do the following when you connect
the camera and display CameraWindow.

el Acquire Images
I=Y Downloads images and sound files from the camera (p. 15).

B Print Images
=3 Selects and prints the images in the camera.

Gl Write to Camera
=Y Uploads images on the computer to the camera.

] Set to Camera
3@ Sets the camera owner's name.

Acquire Images from Memory Card
Downloads images and sound files from a memory card (p. 18).
You can also select images on the memory card and print them.

Transfer Images to Memory Card
Uploads images from the computer to a memory card.

View & Clussdy |:m] YWiew & Classify

View as a Slide Show

Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files

Changes the file names of the selected images in a single pass.

Classify into Folder

Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting

date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.
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Edit
Edit Image ‘ 1 el

Allows you to perform image editing, such as
cropping, image correction, inserting comments, and red-eye correction. You can also use it
to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 35).

Digital Photo Professional - Process RAW Images (certain models only)
Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 36).

Export

Export Still Images s/ Expot
Allows you to change the image size or type,
and export it as a new image.

Export Shooting Properties
Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.

¢ CD-R/RW capable drive supplied as standard equipment

¢ CD-R/RW writing capabilities are operating correctly




E

al] Fiint & Emal ‘

Print & Email

Photo Print
Prints one image per page (p. 20).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Email Images

Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

ZoomBrowser EX has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 39).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 32).
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

0 ¢ Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 ik [Cancel] (@288 in Windows Vista) to close the Events Dialog (or the slide
show screen) if it appears.

If CameraWindow appears, click [Operate Images on Camera] followed by B3 in the View
Window to close CameraWindow.

CameraWindow

[ camon unumies

CameraWindow DC

': ir% { m&m  Operate using the camera
JaThl, L

.&‘ Push the camera buttons.

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window
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3

In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [RemoteCapture DC 3] and [RemoteCapture DC].

According to the default settings, recorded images are saved into the
[Pictures] or [My Pictures] folder. To change the destination, open the
[File] menu in the remote shooting window and select [Preferences].

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard'’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera

is used independently.
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Shows/Hides the
viewfinder or detailed
settings area.

Size and Resolution Selector

- RemoteCaptureTask
File{F) Camera(C}) Shooting(s)

HelpH})
@ Hice “iewFinder
@ Hicie shooting details:

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

=" 2dd comments shown below

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to _ =

display the image \ = o -
appearing in the

Figld anglefflash Shooting settings

Wacro: il

camera’s viewfinder. for = =]
AF-agsist light:
on -

AF operation:
AF unlack

Selects the size and resolution at which images are captured.

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

Set the basic camera settings here.

Iﬁl The settings available vary between camera models.
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 cik [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].

2 Click [1. Select Images] and select several images in the Browser Area.

3 Click [2. Open PhotoStitch].

Instructions

STC.0580PG

—

STD_0581.86

| STA_0576.FG | STB.0S79.9G

s o s 3

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

* Some camera models may not support Stitch Assist mode.

e See the Camera User Guide for information about shooting in Stitch Assist mode.

*Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

¢ Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

¢ The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

¢ You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 dik [Edit] in ZoomBrowser EX's Main Window, followed by [Digital Photo
Professional Process RAW Images].

2 sclect a RAW image in Digital Photo Professional’s Main Window.

]
Selects folders ———
containing
images.
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4 Adjust the image brightness and white balance in the tool palette.

The modified contents (the information for image processing requirements) are saved
along with the image as a “recipe”.
The items available to be modified differ depending on the camera model.

You can adjust all three RGB

channel levels together or

separately with the Tone Curve. Reduces noise that occurs
when shooting night time
scenery, or when shooting
at a high ISO speed.

S o Adjusts the brightness,
white balance and picture
style.

[Pctm e

Adjusts the contrast, color
tone, color saturation and
sharpness.

Tool Palette

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 inthe [File] menu, select [Convert and save], set the file type and destination and
then click [Savel.

Selects the file
destination.

Desking

My Documents

Renames the file. 7
My Compute:

|— — Fienae: MBO0FE 3 e
el EwilJPEGI" 06 " JPEG) - Cancel
| Guaiy sesng

Innage quality a1

Selects the file type. cuptseng

Ouputresoison 350 | dpi ] Emued ICC prafie inimage

Resize seting

FlRees Insert a check
mark here to
change the file
size.
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

ttings oodMy Docusments\Wy PicturestiiG 001 2.CR2 I
Printar  Image |Ted | Betings

Image Sz

Inserts text.

HHHOCOODOONK
H Y
30 | |25 mm

wiem Height

2030 |men [ 1353 mm
m ol E Sets the image size and

image layout, and
8 E shooting information.

[ Comer eaistration manks

[ Carter regishatan marks

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

|— Inserts text.

Commns:
2 Joam

Sets the number and order
EI ) of images laid out on one
Layaut sheet.

O vamcal

Fows

(@ Horizontal

(Fom ) (e ) [remy )
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Enjoy Customizing Your Camera with the My
Camera Settings

I§| My Camera functions are only available with camera models listed as

compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you

install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 Click [Cancel] (=34 in Windows Vista) to close the Events Dialog if it appears.

If CameraWindow appears, click [Operate Images on Camera] followed by E in the View
Window to close CameraWindow.

CameraWindow

Thumbnail Window View Window
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3 In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.

4 cik [Connect to cameral. ESTEZ?
The My Camera window showing HORSERACZ!
images in the camera will display. KABUKIYDZ1 .

Connect to camera

[

Close

5 Select the [Setup as a theme] tab.
To set the start-up image or sound individually, select the [Set individually] tab.

6 sclect the settings to add and replace.

Settings to add: select from the [My Computer] list.
Settings to replace: Select from the [Camera] list.

7 click [Save to Camera]
Clicking [OK] overwrites the settings previously registered on the camera.

My Camera %

Sepasatheme Setndvidushy |

Sakict My Camera Dt 1y 30 56 iy

Das Tuge:
Stattup Image ~

My Comoutsr Camers:

321500

AP

Save to Camera

Displays the
settings saved to

the computer. -«@

[Save to PC] Button
Saves settings files
[Delete] Button registered with the
Deletes settings e camera to the

from the computer. computer.

8 Changing the My Camera settings with the camera.
See the Camera Users Guide.
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Creating Original Start-Up Images or Sounds

You can use My Camera Maker to effortlessly create image files or sound files for use as start-
up images or start-up sounds.

1 inthe [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.
The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.

My Camera Maker will start.

My Camera rg|

Select My Camera Data type and set individually.

Data Type:

[Startup Imageifor comman camesas) =~

My Computer

27 01.JPG Startup Sound
321_SI01.JPG =1

ANIMALO22 S101.JPG Shutter Sound
ANIMALOZ3_S101.JPG

BAR21_SIN JPG Operation Sound
BASEBALL21_SI01.JPG

CHIMPANZ1_SI01JPG Selftimer Sound

ETHDANCEZ_SI01.JPG
ETHTECHNZ1_5101.JPG
FUNZ1_5101 JFG
FUN2Z_5101 JPG
FUN23_SI01.JPG
FUN24_SI01.JPG
GAKKIZT_SI01.JPG

Add File Button BAE 22501 e
Adds images and sound files for use T
as settings files in the list. HORSERALZ1_SI01.4PG

IYASHIZ1_SI0NJPG
KABUKIYD21_SI01 JPG
KIKORIZ1 SI01.JPG ™

addFie_ [l Cieste My Camera data

Delete | Connect to camera i

Close

3 Follow the instructions at the top part of the My Camera Maker window and
create image or sound files.
The created settings files automatically appear in the My Camera window.

Add the files to the camera following the procedures in Adding My Camera Settings to
the Camera (p. 39).
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5

Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images
Image Type
Data Sampling
Resolution (WxH)

e Start-Up Sounds

Type
Bit Rate / Frequency

: JPEG (Baseline JPEG)
:4:2:0 or 4:2:2
:320 x 240 or 512 x 288*

* Varies with camera model

: WAV (Monaural)
: 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the

following chart.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

® Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.
Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

ity
(ﬁ) in the CD-ROM window.

4 Click the Digital Camera Software [Install] button.

— DIGITAL CAMERA

Solution Disk

Installer Panel
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9 click [Exit] in the installer panel and remove the disk

Select [Easy Installation] and click
[Next].

Select [Custom Installation] to select
programs individually for installation.

Click [Agree] if you agree to all of the
terms of the software license
agreement.

Review the installation settings and
click [Next].

Follow the on-screen instructions to
proceed with the installation.

When the installation is over, click
[Finish].

from the CD-ROM drive.
This concludes the software installation.

0 o granted by Canon t you for any inteilectual property o
Geletn 3 coppright natice of Canon andjar Its Ikansers
ng any copy thereal.
2. License: Your lcense 10 use the Saftware is non-exchusive and non-transherable. Vou ars permittd o (1 use the
Safware Puse” shall maan soring. lowdg, Inetalieg, owculing o iokang  sofuaee) o0 Your mikiple
personal use. (2) use the Dat

computers, such as warkstations, terminals or other devices for your own
IRSlruCTeq T be used a3 istalled inta a Canon's dhgital sl or viden camera product in the user docucy

with these procedures.

See Uninstalling the Software (p. 71) to delete the software installed

Continue by downloading images to the computer (p. 45).



This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).

Camera to Computer Connection

1 After connecting the supplied interface cable to the computer’s USB port and the
camera'’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

CameraWindow

BHER®E

H canom U

CameraWindow DC

Thumbnail Window View Window

If CameraWindow does not open, click the [CameraWindow] icon in the
Dock (the bar at the bottom of the desktop).

2 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] folder.

Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

¢ |If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Dhar
(Print/Share) button will light blue.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Dy (Print/Share)
button or the FUNC./SET button.

Direct Transfer

The Dy (Print/Share) button will blink "
blue during the transfer and remain lit DPOF Trans. Images.
when it is complete. Click the mouse = Select & Transfer,,
button or press any key on the keyboard to EJ Wallpaper .

resume the ability to operate from the
computer.
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Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow

U camonu

CameraWindow DC

Click this button to
close the start screen.

Thumbnail Window View Window

*To download images that have had transfer settings set with the
camera, use the camera or a memory card reader (p. 48).
¢ To check images in the camera or to download only a portion of the
images, click [Operate Images on Camera].
*You can choose standard or frame-by-frame playback (OS X v10.4 only)
of movies by selecting a movie in the Thumbnail Window.

=
*You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.

When you click [OK] in the image transfer completion window, the transferred images will
display in the Main Window.

The downloaded images are saved into folders according to the shooting date.

[y —

The lastdownloaded images
will display here according
to both their shooting dates
and categories.

Folders Area
The downloaded symbol
displays on downloaded
folders.

Thumbnail

Next, print out the images (p. 49).
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Memory Card Reader Connection

Insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the

2 ik [Download Images].

ImageBrowser Canon

Download Images

Lets you select and
| download images

You can adjust the settings, such
as the type of image downloaded J
and the destination folder, by - | Print Menu |
clicking [Preferences]. <& —— e T

l ¢
[ —— -

Preferences... Exit

If the window above does not open, click the [CameraWindow] icon in the Dock (the bar
at the bottom of the desktop).

¢ By the default settings, all images are downloaded to the [Pictures]
folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

¢ See Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date or My Category in the [Last
Acquired Images] section.

Next, print out the images (p. 49).
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Printing Images

There are three methods for using ImageBrowser to print images: [Photo Print], [Index Print]
and [Layout Print]. This section explains how to use the [Photo Print] option.

Iﬁl Movies cannot be printed, but you can print still images saved from movies.

Prints one image on each page.

T select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [§8 ] (command) key while clicking on images.

1) Bramses window

2008.06.10
2008_06_11

[#2008_06_12
(#2008 06 13

A blue frame
displays around
selected images.

2 ik [Print & Email] and select [Photo

Print]. & : (Y

Show % email Send to Tras

Ngg__Photo Print... ool

Layout Print...
Create Image for Email...

! Total: § images ;.

Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.

Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.
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3 Ssetthe categories as you feel necessary.

Selects a printer. oo =

Pagas size |
A

Selects options such as the paper size
and orientation when you click
[Page Setup]. Sppared e

Clck [Page Setup] to enable
Borderless printing on

‘Shosting Date,Time

Selects a printing method for the ——— =

shooting date/time information.

¥ig] | Remove unwanted regions of Add or Modify text to print with
] your phata. L e photo.

4 P image: 13

Click this button to switch
between images if you
selected multiple images.

4 Click [Print].
The Print window will now open.

Text can be inserted here to —

Copies: 1] @) Total . 3pages

(fooe )

Sets the
number of
copies printed.

print with this photo.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click [Close] to close the window.

This chapter explained the ImageBrowser basics.

Once you have mastered them, try the advanced techniques.

® Using the Software on the Macintosh Platform — Advanced Techniques (p. 51).



This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

Browser Window

This window is for displaying and organizing images downloaded to the computer.

Last Acquired Display Mode Browser Area
Images (p. 52) (p. 53) (p. 52)

[-X:X:)
Last Acauired images
wigh Show All Images
¥idlSheating Date - "
H2008_06_12 File Mame

382008 06_13 Modified:
villimy Category | 3

Fila Size:
Myreople

Imape Size-
Duta Type
Sound

Lock o

scenery
W evems

Al Foiders

& Mavies
¥ Pictures.
»{ ¥ 2005 06 08
[ 2008_06_09

¥ Star Rating | My Category

[0 z008.06.10
¥ z008_o6_11
[#2008_05_12
L #2008_06_13
w4 iPhata Library

—

ool el Seacind 1ol e

Folders Area (p. 52) Control Panel (p. 54) Display Control Panel (p. 54)
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Folders Area

e Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.

¢ |f you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o If [Favorite Folders] is displayed: click [Add] and select a folder.
o If [All Folders] is displayed: select a folder and click [Add to Favorites].

Last Acquired Images
® You can check images grouped according to the shooting date or My Category.

Browser Area

¢ The folders and the images within the folders selected in the Last Acquired Images section or
Folders Area display here.

The display style will vary according to your Display Mode selection.
¢ The following types of icon will display around images according to their attributes.

Cha Images shot with the camera's Stitch Assist mode

WAVl RAW images

"H Movies

mﬂ Images with sound memo attachments

[Enl  Protected images

E Images shot with the camera's AEB function
¢ Rotated Images (In display only)
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Display Mode

o Selects the display style for the Browser Area.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

* Baskc nformation =
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List Mode

Displays the images in the folder selected in
the Explorer Panel section in rows and
columns.
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.
Display Size Selection Menu
Changes the size of the thumbnail in Click this to select/deselect all
the Browser Area. images in the Browser Area.

|

Viewh’? Filte.rTu«nI .'H Bt IVI e L‘)‘ &k H Seiecting.lmages .'.H(E E E)

Filter Tool Menu Hide Buttons ———————
Displays only images that correspond to the Left: Hidesthe Explorer Panel and
specific conditions. the last downloaded image.

Middle: Hides the control panel.

Right: Hides the Show Shooting
Information panel in the
Preview display mode.

Control Panel
¢ The control panel contains buttons for executing various functions.

3 ¥ = g

Canon Camera View Image SlideShow Print & Email Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 58).



Double-click an image in the Browser Area to display it in the Viewer Window.

(-XaX:] & IME D001 PG (1/7)

Zoom
Changes the
image zoom
setting.
(Frownion W50 8 = — Star Ratings Menu
ey L B T E, LIS L E. Sets the Star Rating
== o5 > = w . foranimage.
Image Selector Button
Switches between .
images. Show Information Menu
Displays shooting information.
Save Button !
Saves the edited image. Print Button
Prints the displayed image.
Edit Menu

Full Screen Button

You can edit, eliminating red eyes,
adjusting colors and brightness, cropping
and inputting titles.

You can also use it to start up other
programs for editing.

Number of Displays Menu
Displays multiple images at

Displays the image in the full screen
mode. (You can also double-click an
image to display it in full screen mode).
Click the image or press any key on the
keyboard to restore the normal display
mode.

Synchronize Button
Synchronizes the display settings when multiple
images are displayed.

once. This is handy for
comparing images.

*RAW Image is Displayed
The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed
*Buttons will appear below the movie, allowing it to be played back or the
sound to be adjusted.
eIf you click the [Save as Still Image] button, you can extract still images from
movies. You can also delete unwanted sections at the beginning or end of
movies by clicking the [Cut Movie] button.
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File Information Window

The File Information Window displays when you select an image in the Browser Area, click the

[File] menu and select [Get Info]. The File Information Window
display mode.

Switches between showing and hiding
detailed information for the category.

File Information

Star Rating

Switches between [
showing and

hiding detailed
information.

¥ Comment

in Kamakura

" Hide Derall )

File Name:

File Size:
ed

e

Data Type:

Sound

IME_0001
2008/06/12 18:22°41
528 KB (537,343 Bytes)
1600 x 1200

PG

¥ Keyword

( View/Modify Keywords. . ——

Plays a sound
memo attach
to an image.

v Brightness Histogram

Lock 0

Lock
Prevents an image
from being
overwritten or
deleted.

¥ Shooting Information

< Back

does not display in the Preview

Star Rating / My Category
Sets the rating for an
image.

An icon will display if a My
Category is set.

Comment
You can type a comment
here.

Keyword
Sets the keywords used in
searches.

Brightness Histogram

A graph of the highlights
and shadows distribution
in an image.

—— Shooting Information
Displays detailed
information, such as the
shutter speed and

{C Next >

W —

Image Selector Buttons File Name
When multiple images are You can change
selected, you can switch file names.

between images that display
information in the File
Information Window.

exposure compensation
setting. The camera model
will determine what
information is displayed.
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ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

your model supports them.

Some ImageBrowser functions may not be available with certain camera
models. Check the Specifications section of your Camera User Guide to see if

The following workflow is used in ImageBrowser.

T  select a feature from the Control Panel or the menu.

(lmanenmwmm Edit View Intemet Window Help

_—
I Close xw
Menu
New Folder EN
Favorite Folders >
g}
e mEat
Move Image...
Duplicate ®D
Send to Trash B
Search... ®F
Export Image...

Organize Image
Process RAW Images by Digital Photo Professional..
Connect 10 Camera...

Rewrite Image to Memory Card...

‘ Index Print..
Sauigy 4 Layour print..

|
———

2 Perform the procedures according to the instructions.

- X:Y.]

Printer

HOORH, ]
( Pgmsemp. )

Papes size

Procedural instructions _‘—(E, e e ||| 59 oty et i )

Check the Help menu for
procedures and features.

T :
NS "
'A
>
b ]
i giSipe
Wew [ e rea
( ~ el
T e e o et et

Index Print....

Layout Print..
Create Image for Emall...

Click [Page Setup] to enable
bard 5 00

Control Panel

A [>] mige 13 copes [ 1)) Tatal:  3pages

Close ) (__pimt )
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i @ = |

Canon Camera View Image SlideShow Print & Email Send to Trash

Canon Camera
CameraWindow will display if the camera is connected, and you will be able to perform the
following actions.
Gl Acquire Images
I=Y Downloads images and sound files from the camera (p. 45) .

% Print
Selects and prints the images in a camera.

] Write to Camera
=Y Uploads images on the computer to the camera.

5] Set to Camera
3@ Sets the camera owner’s name.

You can perform the following actions if a memory card reader is connected.

eDownload images from the memory card
Download image or sound files from the memory card (p. 48).
You can also specify images on the memory card for printing.

eUpload images to the memory card
Upload images from the computer to the memory card.

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.
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Print & Email

Photo Print
Prints one image per page (p. 49).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Create Image for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]
¢ Edit and Save: allows you to change the file type or size and export the file.
¢ Export Shooting Properties: allows you to export the shooting properties as a text file.
eExport as a Screensaver: Exports the image as a screen saver file.
e Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.

*Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [Process RAW Images by Digital Photo
Professional] (certain models only)

Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 65).

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 64).
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Display Settings: [View] menu, [View Settings]
Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]

Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.

ImageBrowser has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 68).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 61).



|

Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

0 ¢ Ensure that you turn off your computer’s sleep mode before you begin

remote shooting. The device performance cannot be guaranteed if the
computer enters the sleep mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 if CameraWindow appears, click [Operate Images on Camera] followed by E3 in the
View Window to close CameraWindow.

CameraWindow
R ED

Canom Urumies

CameraWindow DC

Transfer Untransferred Images
e

Operate Images on Camera

Thumbnail Window View Window
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3

uh

Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [RemoteCapture DC] icon.

According to the default settings, recorded images are saved into the
[Pictures] folder. To change the destination, select [Preferences] from the
[RemoteCapture DC] menu.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

Click the [Release] button.

*You can also release the shutter by pressing the camera’s shutter button
@ or the keyboard'’s space key.
¢ Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.
* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Size and Resolution Selector

Shows/Hides the Selects the size and resolution at which

viewfinder or i
detailed settings images are captured.
area. . .
Rotation Settings
86o RemoteCapture DC Sets the rotation
(3 Hide ViewFinder & [(aL | reiease parameters for
images after they are

e Hide shooting details E o e
You can add — | Add comments shown below =
comments to images
by placing a check
mark here and
typing text in the
boxes below.

captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to

Start/Stop Viewfinder
Button
Starts or stops the

B ="

the cameraisopento [ [Feldangle/flash | shootingsettings . —— | | viewfinder display.
di5p|ay_the_image Focusing Point: Flash:
?e‘x)rale’z%gvmﬁder Macrao: : ;iif:\Quai'rrv: ) pefiggh Button

e B] Resets the exposure,

;\F—assist light: | fOCUS and Whlte

o = B balance.

AF operation:

AF unlock -

Set the camera shooting settings here.

Iﬁl The settings available vary between camera models.
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

T Sselect a series of images in the ImageBrowser’s Browser Area.

2 Click the [Edit] menu and select ene Phorosiich
[PhotoStitch]. 3 g b e e oo b g, weladaed

3 y 'i? 3. Click [2. Marge).
Instructions —

| sTA0578.PC S5TB_0579JPG STC_0580.4PG STD.0581JPC

¥ o, et images 4 1024 = 748 Troe Coar

3 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

¢ Some camera models may not support Stitch Assist mode.

e See the Camera User Guide for information about shooting in Stitch Assist mode.

eImages shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

¢ Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

¢ The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

*You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 Cdlickan image, then select [Process RAW Images by Digital Photo Professional] in
the [File] menu.

2 sclect a RAW image in Digital Photo Professional’s Main Window.

Selects folders
containing
images.
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4 Adjust the image brightness and white balance in the tool palette.

The modified contents (the information for image processing requirements) are saved
along with the image as a “recipe”.
The items available to be modified differ depending on the camera model

You can adjust all three RGB

channel levels together or

separately with the Tone Curve. Reduces noise that occurs
when shooting night time
scenery, or when shooting
at a high ISO speed.

_omzcRz|

Adjusts the brightness,
white balance and picture
style.

Tool Palette

Adjusts the contrast, color
tone, colorsaturation and
sharpness.

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 inthe [File] menu, select [Convert and save], set the file type and destination and
then click [Savel.

Renames the file. » Convert and save
I— Save As: | IMG_0013 (53]
Selects the file ——————————  wnere: || Pictures )
destination. -
File format
| ingequaliy  —
Selects the file type. e
Output resolution 350 dpi ¥ Embed ICC profile

Resize setting

Insertacheck mark ————_ Resize
‘Width Height Unit

here to change the 1316 x

f||e size. 14416 pixel ) (3312 pixel )
| Lock aspect ratio

( cancel )
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

Inserts text.

0 MG _0012.CR2

NOOOEHOHNEXK

XXXXXKHK
=y

Sets the image size and
image layout, and
shooting information.

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

—— |— Inserts text.

Sets the number and order
of images laid out on one
sheet.
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Enjoy Customizing Your Camera with the My
Camera Settings

My Camera functions can are only available with camera models listed as
compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you
install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

1 After connecting the supplied interface cable to the computer’s USB port and the
camera'’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 |f CameraWindow appears, click [Operate Images on Camera] followed by E3 in
the View Window to close CameraWindow.

CameraWindow

uuuuu Umumes

Camera.Window D

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window
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3 Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.

The My Camera window will display.
4 sclectthe type of setting in the Type list box that you wish to save to the camera.

5 sclectthe settings to add and replace.

Settings to add: select from the [Computer] list.
Settings to replace: Select from the [Camera] list.

6 Click the [ - | button.

If a setting for this category has previously been saved to the camera, press [OK] and it will
be overwritten.

7 Click the [Save to Camera] button.
Click [OK] to conclude the process of saving the My Camera settings to the camera.

Save to Camera Save to Computer

Type: | Theme o

Computer

121 —n - || a1
&

321

ANIMALO2Z

Displays the settings saved =————uai0s ——
to the computer. Vo,

CHIMPANZ L
ETHDANCEZ1
ETHTECHNZ1

Add ( Send to Trash )
[Send to Tra!sh] Button — i
Deletes settings from the
com puter Save To:Macintosh HD/Users/ XXXXX /Library/Preferences /ImageBrowserUserData/

Exit )

8 Changing the My Camera settings with the camera.
See the Camera Users Guide.
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Adding Original Start-Up Images or Sounds

You can add original start-up images or sounds created with image editing and other software
to the My Camera Window. Sound files are saved as WAVE-type files.

1 Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.
The My Camera window will display.

2 selectthe [Start-up Image] in Type.

For sound files, select either [Start-up Sound], [Operation Sound], [Selftimer Sound] or
[Shutter Sound].

3 Click [Add].

CHIMPANZ1_SI01.JPG
ETHDANCEZ1_5101.JPG

i i
[Add] Button et
Adds images and sound

files for use as settings & & .\
files in the list.

Canon i

Save t ! [ & Exit

4  sclect the file you created and click [Open].
This concludes the process for adding new data.

You can add the settings files you just added to the computer to the camera using the
same procedures as in Adding My Camera Settings to the Camera (p. 68).

Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images

Image Type : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Resolution (WxH) 1320 x 240 or 512 x 288*

* Varies with camera model

e Start-Up Sounds
Type : WAV (Monaural)
Bit Rate / Frequency : 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the
following chart.

Type Duration in Seconds
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

1 Click the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

| My Dcaanents
[y ———

The uninstall utility will start and remove
ZoomBrowser EX.

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.
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Memory Card Folder Structure

The images on a memory card are placed in subfolders of the [DCIM] folder labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 999.

— IMG_xxxx.JPG (JPEG images)
EI T — _MG_xxxx.JPG (JPEG images recorded in the
DCIM Adobe RGB color space)
XXxCANON L |MG_xxxx.CR2 (RAW images)
—— _MG_xxxx.CR2 (RAW images recorded in the
Adobe RGB color space)
—— STx_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.MOV, MVI_xxxx.THM* (Movies)
— MVI_xxxx.AVI, MVI_xxxx.THM* (Movies)
—— SND_xxxx.WAYV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC
L EI - = EI SDR_xxxx.WAV (Files recorded with Sound Recorder)
SNDR xxxCANON

¢ *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode. If you delete these files, you will be unable to save the movies to the camera from a
computer.

*The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

o All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.

¢ Depending on the camera, some data types cannot be recorded.



Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

@ Does your computer satisfy the requirements listed in the System
g Requirements section (p. 9)?

@ Is the camera correctly connected to the computer?
Q

See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.

@ Are the camera and computer in the correct modes to transfer data?
Q

Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.

@ Is the battery sufficiently charged?

Q
Check the battery charge if you are powering the camera with a battery.
You are recommended to use an AC adapter (sold separately) to power
the camera when it is connected to a computer.

73
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Appendices

Try the suggested solutions to the common problems listed below.

@ Add New Hardware Wizard displays when the camera is connected to
g the computer with an interface cable (Windows).

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

@ Cannot download images or shoot remotely. (For cameras connected to
g the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by
following the procedures below.

Solution:
Hold the MENU button on the camera down and press the Dyas (Print/Share)

button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.

@ Camera not detected, Events dialog won’t display or images will not
g download to the computer (when camera is connected to the computer
via an interface cable (Windows)).

The camera may have been recognized as another device under the

following circumstances (Windows only).

® The [Scanners and Cameras] icon cannot be found in the [Hardware and
Sound] within the [Control Panel] or the [Printers and Other Hardware]
window.

¢ Your camera model name, [Canon Camera] or a camera icon does not display
when [Scanners and Cameras] icon is clicked.

Solution:
Delete the device with the following procedures.

You must be authorized as a Computer System Administrator to delete
devices.

1. Display the [Device Manager] dialog.
Windows Vista: Click the [Start] menu, [Control Panel], [System and
Maintenance], [System], and Task list [Device Manager].
Windows XP: Click the [Start] menu, [Control Panel], [Performance and
Maintenance], [System], [Hardware] tab, and the [Device Manager] button.
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2. Click the [#] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories
if it is being recognized as an “other” device.

Fle Aton Vew Hep Pl aon vew Hep
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There are other potential reasons for the problem if the “Other
devices”, “Portable Devices” or “Imaging devices” categories do not
appear or your camera model name or [Canon Camera] does not appear.
Proceed to Step 5, and temporarily quit the procedures.

3. Select your camera model name or [Canon Camera], right-click and select
[Delete].

4. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

5. Close [Device Manager] or [System Properties].
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Appendices

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel].
2. Display the [Hardware acceleration] setting window.

Windows Vista: Click [Appearance and Personalization], followed by [Adjust
screen Resolution], [Advanced Settings] button and [Troubleshoot] tab.

Windows XP: Click the [Appearance and Theme] icon, followed by the
[Display] icon, [Settings] tab, [Advanced] button and [Troubleshoot] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

An error message "Insufficient free memory" displays when

using PhotoStitch

Please try one of the following methods.

e Close all other applications other than PhotoStitch.
e Reduce the size or number of images to combine.
¢ |n the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce the size.
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Downloading Images without Installing the
Software

You can download images by simply connecting the camera to a computer, without installing
the software bundled on the Canon Digital Camera Solution Disk.
However, please note that there are several limitations.

Iﬁl If you use the bundled software, the following limitations do not apply.

e [t may take a few minutes, after connecting to the camera, until you can download images.

¢ The camera information (firmware version, etc.) may not display correctly. In this case, use the
software from the Canon Digital Camera Solution Disk.

e Sound files attached to still images as sound memos and sound files recorded with the Sound
Recorder function may not download depending on file size and software used.

*RAW images or JPEG images recorded at the same time as RAW images may not be
downloadable with some software programs or operating systems.

¢ Movies may not download correctly if the file size or software program is incompatible.

e|mages shot in the vertical orientation may be downloaded in the horizontal position.

¢ The protection setting for images protected in the camera may be lost when transferred to
the computer.

¢|n addition, there may be problems with downloading images or image information correctly
depending upon the version of the operating system in use, the file size or the software in
use.
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